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® MySIM is your Online Booking Portal for Cockpit Simulator Trainings with
Lufthansa Flight Training.

® \Whether you would like to request or directly book training slots, or rebook or
cancel a previously made booking, now you can do all of that online.

®m Highlights
® You can make bookings whenever you like — 24 hours, 7 days a week.
® The new features enable you to make most of the transactions yourself.
® MySIM is easy-to-use — filters let you see the necessary details very quickly.
®m Our planning team is still there to assist you, quickly and efficiently.

® We invite you to take a tour through this step-by-step-guide to explore the
advantages of MySIM.
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Introduction

© by Lufthansa Flight Training

B This short introduction explains the
basic elements of MySIM.

B Screenshots show the actual layout
and contents of MySIM.

B Highlighting effects highlight different
functions and options.

M Filter options help you to select the
required slots quickly. You can focus
on details that matter to you.
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Two different views offer you two different ways

to work with MySIM
e

= MySIM offers you two options to see and work with simulator slots. You can work in the
Booking Overview (Part 1), or via the List View (Part 2). Both methods are easy-to-use.
Choose the one that suits you most — or simply get the best of both worlds.

1. Booking Overview: 2. List View:

> Filter Clear Filter > > Filter Clear Filter >

From To
<[> Augzniz @ Month Wesk [oaminz >
Use Filter >

Favorites All Simulators

Availahilities Requests Offers Confirmations Histary
Favarite list1 el L&

The listed times are slots (status available) for training, that have heen offered to you in order to easily book your training. Please note that these slots are not
exclusively reserved for you, they are subject to prior sales.

Showing 1- 50 of 206 results. - - I4 First o Previous | Mest b Last |
> A320 FTA5 FRA 2nd choice @@0 W Favortes ters per Page [EOTE)  Paoe [T o5
v AT20 FTEE FRA and choice 800 & Favorites L] St Farnily FT-Mao Location Date & Start End Duration Action
r A320 F131 BER o212 0310 06:40 0330 N
Aug 2012
[m] A320 FT86 FRA o&2112 0325 0855 0330 v
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. 2 T05- 1508 N r A3z0 FT51 BER 082212 0310 0640 03:30 v
3 1510-1810 O 4320 FTE6 FRA 082212 0325 06155 0330 v
4. 1915-2315 [m] A320 FT8s muC 08122112 0325 0655 03:30 v
5 2330-0320 . [m] A320 FTs1 BER 08122112 0845 (L2 04:00 v
— r A320 F18S Muc o&i22M2 aF:00 1:00 04:00 v
available [ Motavsilable %7 Pending [ oOffer [l confirmed [ Taken [l Mot Taken
Ayailable slots are visible on relevant simulatars for the next 6 weeks O AZ20 FT88 FRA 0822112 1:08 1508 04:00 v
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1. The Booking Overview

B Click on one particular simulator slot @ e —

and you can — _ CioatFiter >
- request an available slot o e e e S
Favorites _I Al Girmulators
- confirm, reject or shift a slot that has Eaeted L= ]
been offered to you .
» 738 FT35 BER: 1stchoice @@ & Favorites
. ¥ ind choice @20 & Favorites
- rebook or cancel your previously E—— o o
R ~ T63 FT41 FRA 1stehoice @@@ & Favorites
confirmed slots P
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| |
IIIIII
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hi
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0 ofer | confrmed [l Taken M Cowntime B WotAvailable | Available [ Mot Taken
Awailable slots are visible on relevant simulators for the nest 6 weeks.

18:15- 2315
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1.1 How to request a slot (1/2)

Your simulator bookings.

B Please select the option Booking Overview

ooking Qverview
from the welcome page — the first page after JREE
. . > Availability b Bst
your successful log-in into MySIM. » Bookng Raques
» Annual Requirement
) i Diownloads
B Select your preferred simulator and click on > Teshrieal Simuiator Docurents
the available slot (light gray color) you want S — ot
tO request. 4 :\ghlttlckets
(Example: Wednesday, September 26, 2012, > Other Travel Seices
slot 2,11:.05-15.05hrs) _———— .
N A32U FTBE FRA 2nd choice @ @O Favatites
Sep 2012
B A small window opens up. Click on 51 52 U5 04 05 08 07 53 58 10 11 13 13 14 12 18 15 18 19 20 %1 33 ?SEE % 27 2 28 3 01
“Request” to continue. e | | | [ LTI
11:05-15:05

1810-19:10

ol | | | [T
o IR NN

available [ Mot Available [l Downtime 72 Pending [ offier [l confirmed [l Taken [l Mot Taken
(20.0h}) (40.0h) (0.0h)

Fyailable slots are visible on relevant simulators for the next 6 weeks

LA R ™~ = =
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1.1 How to request a slot (2/2)

-]
B A new window appears, the booking request. Please enter Booking Request
T~

the necessary information. LFT needs the following fields to
Simulator, AJZ0FTEE FRA
answer your request: Customer, Customer Code, Dry/Wet
Diate: 260012
and Type. Time of day: 5-15:05LT
(=
. The tWO movable Slldes under the Slot time Can be adjusted :ealseﬂll:utthefollowmgﬁeldswithyourbool-;inii:forlrnatmn.Fieldsmarkedwithamasterisk*aremamdatom
to your needs. | | |
Crew Murmber:
|
: R ) Diriet and Type*: Lesson Mumhber:
B If you mark the request as binding the slot will be booked e S
- . . . R Configuration™®
immediately with the status confirmed. Otherwise LFT would == ﬁsew L]
) ) his regqurequestis binding and the sirulator slotwill immediately be booked into the status "confirmed"
offer the requested slot to you before your confirmation. %

B Complete your request by clicking on “Add to Shopping Cart”.
A new window appears, informing you that the request has x
successfully been added to the shopping cart. Request

‘four Request has been added to the shopping cart
To complete the transaction, please go to the shopping cart and follow the instructions

B Go to your shopping cart. Accept the General Terms and ETT—
Conditions and click on “Send” to send your request to LFT.
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1.2 How to confirm a slot

Booking Overview Close View >
B On the page before you learned how to
make a binding new request to have the slot - = —— e
Confirmed Immediately. ‘ L< > Aug 2012 @ Morth 7 Week Wg
Favarites All Simulators
. ; |Favarite list 1 =l (=]
B Here you will learn how to confirm slots that o
are on offer. — P——— —
» 738 FT46 BER Zndchoice @@ W Favorites
B Please click on the offered slot (orange e e

We Th Fr Sa Su Mo Tu We|Th| Fr Sa Su Mo Tu ¥e Th Fr Sa Su Mo Tu we Th Fr Sa Su Mo Tu We Th Fr

color) you want to confirm b NN RN R LSRR RN RS
: 03:25- 06:55 . e i Tl .= 1 I . Nl

e ..... . I . ===== =====
Canfirm 5

07:00-11:00

® Click on “Confirm”. A new window appears,
informing you that the confirmation has -
SuCCessfu"y been added to the Shopping 0 orer Il confirmed -aken W Cowntime B motavailable . Awailable W rot Taken

syailable slots are visible an relevant simulators for the nest 8 weeks

cart. *

1510-19:10

Reject

T8 2315

a9 N =@

Confirm

B Go to your shopping cart. Accept the S -
General Terms and Conditions and click on
“Send” to send your confirmation to LFT.

Close >
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1.3 How to shift a slot (1/2)

B Please click on the offered slot By endien _,
(orange color) you want to shift.
* Filter Clear Filter 3|
B Now click on “Shift”. s Aug 202 & North  week TP
Favorites | All Simulators
B A new window appears (see next Faverte ot L 2]
slide). Please click on an available v
SIOt (Iight gray Color) that you prefer » 738 FT35 BER 1stchoice @@ @ W Favorites
. > 738 FT46 BER 2ndchoice @@o W Favorites
instead. You may even select
) ) i ~ TEIFT41 FRA 1stchoice @@ @ @ Favorites
another simulator and configuration pug 2012
of the Same aircraft type_ _— We Th Fr Sa Su Mo Tu %\ie Th| Fr Sa Su Mo Tu e Th Fr SaI:MU Tu We Th Fr Sa Su Mo Tu \We Th Fr
e Hlllllilllll
: 3. 15‘1!]‘—19‘1]] r E::ef:::tm ... ... &
Lo HEEN | © / gmaamd m
o S S (R i

7 orer [ confrmed [l Taken [l Downtime B Motavailanle available [l Mot Taken
#vailable slots arevisible on relevant simulators for the next 6 weeks
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1.3 How to shift a slot (2/2)

M You can also determine that only the exact
dates are being considered for the change, or
indicate a range of £ 3 or £ 7 days. In addition
you can choose your preferred slot.

B To complete the shifting of the simulator slot
please click on “Add to Shopping Cart”.

B A new window appears, informing you that
the shift has successfully been added to the
shopping cart.

B Go to your shopping cart. Accept the General
Terms and Conditions and click on “Send” to
send your request to LFT.

Fram

Simulatar: TE3FT41 FRA
Location: FRA

Dryiwet Lease Oy

Date! 0814112

Tirne of day: 11:06-15:05 LT
To

Inthe overview please select a new slotin arder to proceed the reposting
Ifthere's no slot availakle for your required time frame, you can select a different simulator of the same aircraft type

Simulator®, Configuration®
|763 FT41 FRA Ll |Please select Ll

03:25- 06:59

07:00-11:00

11.05-149:05

16:10-18:10

19:15- 2319

Nk w N =

23:20-03:20

" Cansider range of+ 3 days forreposting.

CPreferred slop !+ 1 dars foreggs

Add to Shopping Carty

Cancel >

Shift
‘four shifing has heen added to the shopping cart
To complete the transaction, please go to the shopping cart and follow the instructions.

Close >
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1.4 How to reject a slot (1/2)

Booking Overview

. Close View >
M Please click on the offered slot (orange -
color) you want to reject. I —
] ) [<][2] mugzo12 @ Month " Wesk [taninz >
B Now click on “Reject”. ‘
Favorites | All Simulators
|Faworite list 1 T E]
> 7368 FTa5 BER 1stchoice oo @ W Favarites
> 738 FT46 BER 2nd choice @@ o W Favaorites
v 763 FT41 FRA 1stchoice ooo W Favorites
Aug 2012

We Th Fr Sa Su Mo Tuo WelTh|Fr Sa Su Mo Tu We Th Fr Sa Su Mo Tu We Th Fr Sa Su Mo To We Th Fr
a1 02 03 04 05 96 o7 UB ag (10 11 12 13 ‘I4 19 16 17 18 19 20 2‘T 22 23 24 25 26 2T 28 29 3031

il | | B ] O
o7 nn—.h 00 .. .... .....
1106 1508 . Confirm .... .....

T810-19:10 Reject

T9016-33:15

_§ | e ([ BEEEER

0 ofer W confirmed [l Taken [l Dowrtime B Motavailable | svailable [l Mot Taken
Auailable slots are visible on relevant simulators for the next 6 weeks

I
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1.4 How to reject a slot (2/2)

B A new window appears. Please indicate
the reason why you would like to reject the
slot. It will help us to improve your offers in
the future.

B Please click on “Reject” to complete the
transaction.

B Please note that rejecting slots on offer is
free-of-charge.

B A new window appears, informing you that
the rejection has successfully been added
to the shopping cart.

B Go to your shopping cart. Accept the
General Terms and Conditions and click
on “Send” to send your request to LFT.

Reject

In order to hetter meetyour dermands for future planning we kindly askyou to indicate the reason for your cancellation.

|Pleage select v

Cancel > Reject b /)?
LW,

Reject

‘our rejection has been added to the shopping cart
To camplete the transaction, please goto the shopping cart and follow the instructions.

Close >
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1.5 How to rebook a slot (1/2)

B If you decide that the dates for confirmed slots | - #s0rmesrra & o
. Sep 2012
are no longer suitable, you can rebook them. T T s a

il | | | | ([ [ LT
el | | | | (L]

1:05-15:05

B Please click on the confirmed slot (dark blue
color) you would like to rebook.

16:10-19:10

19:15- 2315

Cancel
oo AR ") -
N

mvailable [ Notavailable [l Downtirme 2% Pending [ offer [l corfirmed [l Taken [l Mot T
(20.0n) (40.0h) (0.0h)

Available slots are visible on relevant simulatars for the nesxt 6 weeks.

L T

B Please click on “Rebook”.

B A new window appears (see next slide). Please
click on an available slot that you prefer. You
may even select another simulator and
configuration of the same aircratft type.
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1.5 How to rebook a slot (2/2)

B Please note that rebooking may incur

additional costs depending on the contract

between your company and LFT.

B To complete the rebooking of the simulator slot
please click on the option “Add to Shopping

Cart”.

B A new window appears, informing you that the
rebooking has successfully been added to the

shopping cart.

B Go to your shopping cart. Accept the General
Terms and Conditions and click on “Send” to

send your rebooking to LFT.

Rebook

From

Simulator: AJ20 FTEE FRA
Location: FRA

Dry /Wet Lease Dry

Date: 250812

Tirme of day: 1915-23:16LT
To

Inthe overview please select a new slotin order to proceed the rebooking.
Ifthere's no =lot available for your required time frame, you can select a different simulatar of the same aircraft type.

Simulatar: Caonfiguration®:

|A320 FTE6 FRA e =31] B4
o sepaniz Ot 2012

Tu We Th Fr Sa Su Mo Tu e Th Fr Sa Su Mo Tu We Th Fr Sa Su Mo Tu e Th Fr Sa Su Mo Tu
25 26 27 28 29 30 01 02 03 04 05 08 OF 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23

ouzs-05s [N [ ENEEEEEEEEEEEEEEE

—— il HEE

1:058-1505

e S EEEEREEENENERED
1

e | HINEENEER EEREEER

23.20- 02:20 .. .. .. ..

4| | |

N

ll | have ta en notice that additional costs might occur due to the rebooking of my booking,

o Add to Shopping Carty

Rebook

“our rehooked slothas heen added to the shopping cart.
Ta complete the transaction, please go to the shopping cart and follow the instructions

Close >
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1.6 How to cancel a slot (1/2)

Close View >

B Please click on the confirmed slot (dark blue BogKIgCVEINEW
color) you want to cancel. T o—

4l Aug oz & Month € eek [oamiz >

B Please select the option “Cancel”.

Favorites | All Sirmulators
iFavume list1 i) |j
q 2
> A3 FT47 FRA 1stchoice @@ @ Favorites
> AB33/346 FTAS MUC Znd choite @@0 & Favorites
~ AZ43FT27 FRA 1stchoice @o@ @ Favorites
Aug 2012

we Th Fr Sa Su Mo Tu We
01 02 03 04 05 0B 07 08

Th|Fr S5a Su Mo Tu e Th Fr Sa Su Mo Tu We Th Fr Sa Su Mo Tu we Th Fr
09|10 11 12 13 14 15 16 17 18 19 200 21 22 23 24 25 26 27 28 29 30 A

0. 03:25-08:55 |.. ..
1. 07:00-11:00 T i .. et} - . 1
S EEENEpE——=s g ENENEEE

»

N Rebook ' A

0 ofer M conrmed [ Taken M Downtime [ MotAvailable | Available [l MotTaken
Auailable slots are visible on relevant simulators for the next 6 weeks.

3. 1810-1810

4. 1915-2315

5. 23:20-03:20
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1.6 How to cancel a slot (2/2)

A new window appears. Please
indicate the reason why you would like
to cancel the slot. It will help us to
iImprove your offers in the future.

Please note that cancellations may
incur additional costs depending on
the contract between your company
and LFT.

Please click on “Cancel Booking”.

A new window appears, informing you
that the cancellation has successfully
been added to the shopping cart.

Go to your shopping cart. Accept the
General Terms and Conditions and
click on “Send” to send your
cancellation to LFT.

Cancel Booking

Simulatar: AZ4IFTITFRA

Location FRA

Dy iiet Lease: Dry

Date: 03,1612

Time of day: 1510-1910LT

Cancel LS

In order to better meet your demands for future planning we kindly ask you to indicate the reason for your cancellation.

Flease select =)
L | have taken notice that additional costs might occur due to the cancellation of my booking.

Cancel Booking ’f

Cancel

Your cancellation has been added to the shopping cart.

To complete the transaction, please go to the shopping cartand follow the instructions.

Clase >

Your Online Booking Portal MySIM - A Step-by-Step-Guide
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2. The List View

The List View offers 5 different features:

|_|St V|EW Frint ¥ Close Yiew >
* Filter lear Filter >
Availabilities Fequests Offers Confirmations History

The listed times are
simulator slots, that
have been offered to
you by Lufthansa
Flight Training.

Please note that
these slots are not
exclusively reserved
for you, they are

subject to prior sales.

The listed slots
summarize all slots
that you have

preferably requested.

The listed slots have
exclusively been
offered to you by
Lufthansa Flight
Training according to
your training needs.

The listed slots
show your confirmed
training times.

Here you will find the
history of all
transactions
processed via MySIM.
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2.1. How to request a slot (1/2)

B Please go to the List View and click on
“Availabilities“. You find available training List View L] ooen
times on all simulators for at least the TR

upcomlng Seven days Glabiliﬁes ) Requests Offers Confirmations History

The listed times are slots (status available) for training, that hawve been offered to you in order fo easily bookyour training. Please note that these slots are not
exclusively reserved for you, they are subject to prior sales

. Please Choose the SimUIator Wlth the Showing 1 - 10 0f 63 results temz perPage 10 =]  Page 1 <]tz Pt dPrevious [neh | Lasthl
available SIOtS and SeIeCt One Or more i SIM Family FT-Mo. Location Date & Start End Dwration Action

Q340 FT36 FR& agninz 0325 06:55 0330
slots that you want to request. ’
540 FT63 MLIC aaMinz 0415 06:00 01:45

. In Order to Conf”’m your request you Can O A330/540 FT38 FRA 08A1H 2 07:00 1:00 04:00
r AZE0/540 FT27 FRA 0812 1510 1910 04:00

either click on the checkmark symbol on O |aoow
the right side (to confirm one single slot) i o . VA O O

K&‘\'&\'&'&@k

or use the “Request" button on the bottom r A330/340 FT27 FRA, 0ai1 212 e 1100 0400

. i Showing 1 - 10 o1 83 results tems perPage 10 <[ Page| 1 _v|ar7 it dPrevious [neth | Lasthl
left (to confirm a selection of slots at -~
once).

Your Online Booking Portal MySIM - A Step-by-Step-Guide % Lufthansa Flight Training
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2.1. How to request a slot (2/2)

® A new window appears, the booking request. Please Booking Request

enter the necessary information. LFT needs the
following fields to answer your request: Customer, e i
Customer Code, Dry/Wet and Type. T (O
) ) Customer®: IE‘.ubCusiumEr
® The two movable slides under the slot time can be ' s
adJUSted to your needs. %hls reqisz:t\shindingandthasmjatnrslitww\l\mmematelyhahnnkadmtnlhastatus"mnﬁrmad”
® If you mark the request as binding the slot will be R W

booked immediately with the status confirmed.
Otherwise LFT would offer the requested slot to you e
before your confirmation. e

‘four Request has been added to the shopping cart
To complete the transaction, please go to the shopping cart and follow the instructions

Close

m Complete your request by clicking on “Add to Shopping
Cart”. A new window appears, informing you that the

—reguesthassueeessfully been-addedtothe shoppirg—————————

Calct‘.r Online Booking Portal MySIM - A Step-by-Step-Guide % Lufthansa Flight Training
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2.2 How to confirm a slot

B On the page before you learned how to make a binding new it view o S
request to have the slot confirmed immediately. . |
Here you will learn how to confirm slots that are on offer. Offers

The listed slots have explicitly been offered ta you by Lufthansa Flight Training according to your training needs.

Showing 1 - 10 01 88 results. HemsperPage 10 |  Page|1 v|ora  [dFimt | dPrevieus | Hei b | Last bl

. Please go tO the List VieW in MySIM and CIiCk On “Oﬁers“- |l ?Ia'\lnw\y FT-Mo. Location Date & Stat End  Duration ‘El‘g‘/ Furpose Customer gastﬂnmar ﬁ;ew gﬂgtnmar 5):‘3 Sgtae’ Action
Select one or more slots that have been offered to you for
FT62  BER 08/M1M2 2320 0320 0400 Dy Ty K=

your training. W PO PO O A N D)

FT62  BER 081212 2320 0320 0400 Dy Ty K-

[T ¢simer Fla1 FRa 0BMMAZ 1915 2315 0400 Dy Ty K=

m} FT62  BER 0811312 1105 1505 0400 Dy Ty X

B In order to confirm the offer you can either click on the b b e heleahn | e
checkmark symbol on the right side (to confirm one single - .. . v s o o0 0w o0
offer) or use the “Confirm” button on the bottom left (to il il i ol el
confirm a selection of offers). AN -

[T 7s7mer FT41 FRa 08M4M2 1:05 1505 0400 Dy R LK

HemsperPage 10 | Page|1 -[ora M Fint | dPrevious | Hest b | Lasthl

B A new window appears, informing you that the confirmation “@ e

has been successfully been added to the shopping cart. o ;
ontirm
B Go to your shopping cart. Accept the General Terms and
Conditions and click on “Send” TR

Your Online Booking Portal MySIM - A Step-by-Step-Guide @ Lufthansa Flight Training
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2.3 How to shift a slot (1/2)

|_|St V|eW Frint > Close View >

B Please go to the List View and click on
“Offers*. T

Availabilities Requests ( Offers ) Confirrnations History

. Please SeleCt One SIOt that haS been The listed slots have explicitly been offered to you by Lufthansa Flight Training according tayour training needs
offered to you for your training and that torcpurooe R oo e 141 | 4P b Lot

Ou Want to Shift ™ &M FT-Mo. Location Date & Start End  Duration Dryd  Purpose Customer Customer Crew  Sub e Offer Action
y . Family et Code Mo Customer  date  date
STRET  FT#1 FRA 082 1915 2315 0400 Dry Type Ra S K=

. . FTE2 BER 031112 2320 0320 04:00 Dry Type Ra /
B Click on the arrow symbol on the right @

. . . TRET  FT41 FRA 08M242 2320 0320 0400  Dry  TypeRa VK-
side in order to shift your slot.
o FT62  EER 08A22 2320 0320 0400  Dry  TypeRa VX
o FT62  EER 08A3A2 11:05 1505 0400  Dry  TypeRa VX
[T rstmer FT41 FRA 08A3A2 1510 1910 0400  Dry  Recurs VX
[T rstmer P4 FRA 08H3H2 1845 2315 0400  Dry  TypeRs X
o FT62  EBER 08M442 0255 0655 0400  Dry  TypeRa K-
Il FT62  BER 087142 OFO0 1100 0400 Dry  TypeRa VK-
[T 7ariver FT#1 FRA 081412 1105 1505 0400 Dry  Recurre VXK=
Showing 1 - 10 of 88 results ltemsperPage 10 v|  Page| 1 v|ofg  I4Firt |4 Previous | Hext b | Last bl
Lb selected canfirm 5 Reject 5 Update Crewinfo >
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2.3 How to shift a slot (2/2)

B A new window appears. Please click on an
available slot (light gray color) that you prefer
instead. You may even select another simulator
of the same aircraft type.

B You can also determine that only the exact dates
are being considered for your changes or indicate
a range of £ 3 or £ 7 days. In addition you can
choose your preferred slot.

B To complete the shifting of the simulator slot
please click on “Add to Shopping Cart”.

B A new window appears, informing you that the
shift has successfully been added to the shopping
cart.

B Go to your shopping cart. Accept the General
Terms and Conditions and click on “Send” to send
your request to LFT.

From
Simulator: 772 FT62 BER
Location BER
Dry /et Lease Dry
| Date: oginz
i Tirne of day: 2320-03:20LT

To

Inthe overview please select a new slot in order to proceed the reposting,
Ifthere's ni slot available for your reguired time frame, you can select a diferent simulator ofthe same aircraft type.

Simulator

772FT62 BER ||

101 12 13 14 15 16 17 18 1@ 20 21 22 23 24 25 26 27 28 29 30 31 01 02 03 04 O

07:00-11:00

Ti05- 1505

1510-19:10

19:15-2315

LA o

2320-03:20

|I elect 41l -

Cancel >

Fr|5Sa Su Mo Tu Ve Th Fr Sa Su Mo Tu ¥We Th Fr Sa Su Mo Tu We Th Fr S5a Su Mo Tu W
03:25-06:55

Add to Shopping Cart»

Shift

“our shifting has heen added to the shopping cart,

To complete the transaction, please go to the shopping cart and follow the instructions.

Close >

Your Online Booking Portal MySIM - A Step-by-Step-Guide
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2.4 How to reject a slot (1/2)

. N - |_ tV rin > ose Yiew »
B Please go to the List View and click on e - -
“Offers“. > Filter Clear Filter >
‘ Availabilities Requests ( Offers ) Confirrnations History

M Select one or more slots that you want to

reject. Showing 1 - 10 of 28 results.

™ M

® Click on the X symbol on the right side in
order to reject the slot or use the “Reject”
button on the bottom left.

r

Family

™ rstimer

TITET

T

T

TETRET

TETRET

T

Eirs

TETET

FT-Mo. Location Date &

FT41

FTE2

FT41

FTE2

FTE2

FT41

FT41

FTE2

FTG2

FT41

FR&

BER:

FRa&

BER:

BER:

FR&

FR&

BER:

FRA,

Showing 1 - 10 of 28 results.

L. selected

Canfirm

081112

081112

081212

0s12h12

0813412

0813412

0813412

0514412

081412

08014012

Gtart  End

1915 2315

2320 0320

2320 0320

2320 0Z20

11:05 1505

1510 1910

1915 2315

055 0655

omo0 1100

11:05 1505

Duration Dry !
Wifet

04:00

04:00

04:00

04:00

04:00

04:00

04:00

04:00

04:00

04:00

Dry

Dry

Dry

Dry

Dry

Dry

Dry

Dry

ltems per Fage 10« |

Purpose Customer

Type Ra

Type Ra

Type Ra

Type Ra

Type Ra

Recurre

Type Ra

Type Ra

Type Ra

Recurre

ltems per Fage 10« |

> Reject > Update Crewinfo

>

The listed slots have explicitly been offered to you by Lutthansa Flight Training according to vour training needs.

Page 1 _=|ofg

Customer Crew
Code Mo

Page 1 »|ofg

Sub Cue
Customer  date

4 First | 4 Previous | Mest b | Last bl
Offer  Action
date

o K=

(%

K-
o X -
o X -
o Y-
o Y-
VK-
X

[4Fist | 4 Previous | Med b | Last bl
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2.4 How to reject a slot (2/2)

B A new window appears. Please indicate the
reason why you would like to reject the slot.
It will help us to improve your offers in the
future.

M Please click on “Reject” to complete the
transaction.

M Please note that rejecting slots is always
free-of-charge.

B A new window appears, informing you that
the rejection has successfully been added
to the shopping cart.

B Go to your shopping cart. Accept the
General Terms and Conditions and click on
“Send” to send your request to LFT.

Reject

In arder to better meet your dermands for future planning we kindly ask vou to indicate the reasan for vour cancellation

[F'Iease select i

- > @

Reject

Your rejection has been added to the shopping cart.
To complete the transaction, please go to the shopping cart and fallow the ihstructions

Cloge >

Your Online Booking Portal MySIM - A Step-by-Step-Guide
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2.5 How to rebook a slot (1/2)

® Please go to the List View and click LSt View oo e —
on “Confirmations”. — R X
) Fram To
B Choose the booking that you would o o o ,
like to rebook.
Availapilities Requests Offers Q Confirmations ) History

M Please click on the arrow symbol on e e oo nes
the right side in order to rebook

[~ SiMFamily FT-Mo. Location Date & Start End  Duration Dryf'Wet Purpose  Custorner  Customer Code  Crew Mo, Sub Customer  Action

yo ur s I Ot = AZIOGE40 FT47  FRA 100142 2320 0320 0400 Dry Type Ra X=
.
= 330/340 FT47  FRA 100312 2320 0320 0400 Dry Type Ra X @
@400 F1s4 | VE 100112 0340 0710 0330 Dry Type Ra K=

Showing 3 results.

selected Cancel > Update Crew Info >
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2.5 How to rebook a slot (2/2)

B A new window appears. Please click on an
available slot that you prefer. You may even
select another simulator of the same aircraft

type.

B Please note that rebooking may incur
additional costs depending on the contract
between your company and LFT.

B To complete the rebooking of the simulator
slot please click on the option “Add to
Shopping Cart”.

B A new window appears, informing you that
the rebooking has successfully been added to
the shopping cart.

B Go to your shopping cart. Accept the General
Terms and Conditions and click on “Send” to
send your rebooking to LFT.

x
Rebook
From
Simulator AJ3IFT4T FRA
Lacation: FRA
Diry fiivet Lease Diry
Date: 10/0312
Time of day: 23:20-0320LT

To

I the gweriew please selecta new slotin order o groceed the rehooking.
Ifthere's no slot available foryour required time frame, you can select a different simulator of the same aircraft type.

Simulator:

A333FT4T FRA Lzl

Oct 2012

0325 - 06:55

07.00-11:00

11:05-15:05

1510-19.10

1915- 2315

bl ExlEE R A

2320- 0320

| |

T 1 have ta)aken notice thet addiionsl costs might ocewr due 1o th rehoeking of my bosking.

Gancel : Add to Shopping Cart> >

| Rebook
| “Your rebooked slot has been added to the shopping cart
- To comnplete the transaction, please go tothe shopping cart and follow the instructions.
Closa >

Your Online Booking Portal MySIM - A Step-by-Step-Guide
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2.6 How to cancel a slot (1/2)

B Please go to the List View and s Bl AN
click on “Confirmations®. — —
B Please select the confirmed [F:;m [ijm Use Fifer ,
simulator slot that you want to
cancel. Availabilties Requests Offers ( Confirmations ) History
The lsted sots showyour confimee raining fmes
B To process your cancellation  TamFamiy [Frno. [ Losston [ats & [san [Ena [urten [orpiwet | umose |custmer | Gusmmer Gods | crema. | 6ub Gustormar | acton
click on the X symbol on the right SRl L L e i Gl B LU N
side or use the “Cancel” button S S S O ) O IGO N -
on the bottom left. Lm
selected Cancel > JaecCrewinin >

Your Online Booking Portal MySIM - A Step-by-Step-Guide @ Lufthansa Flight Training
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2.6 How to cancel a slot (2/2)

B A new window appears. Please indicate the
reason why you would like to cancel the
slot. It will help us to improve your offers in
the future.

Cancel Booking

By choosing a reason far your cancellation fram the drop down menue you help us to increase the planning reliability foryour future demand.

Please select Ll
. Please nOte that Cance”atIOﬂS may InCUf' @ken notice that additional costs might occur due to the cancellation of my booking.
additional costs depending on the contract

between your company and LFT. e > m

B Please click on “Cancel Booking”.

B A new window appears, informing you that x
the cancellation has successfully been orr
added to the shopping cart.

Your cancellation has been added to the shopping cart
To complete the fransaction, please go to the shopping cart and follow the instructions.

B Go to your shopping cart. Accept the ciose :
General Terms and Conditions and click on
“Send” to send your cancellation to LFT.

Your Online Booking Portal MySIM - A Step-by-Step-Guide % Lufthansa Flight Training
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3. The History Option

B Here you will find the history of all List View

Frint 13 Close View >
transactions processed via MySIM.
> Filter ﬁ Clear Fllter >
>~
B The maximum time period includes the | e
current year and the last year. e . R

‘ Availabilities Requests Offers Confirmations ( H'Stﬁ@

. You Can SearCh for paSt transaCtlonS Please find all information regarding the histary of your slots that have been processed via MySIM below.
using all available filters. sy 18 st

ast Change Action Actor Mew Status Slot Booking Infarmation
031312 1456 Reguested Funde3, Testd PERDIMNG 031442 07:00-11:00 A343FT3EFRA ®
. A C I rCIe Sym bOI 0 n th e Ieft S I d e g IVeS 00312 14:50 Confirmed LFT Planning COMFIRMED 030512 00:10- 0320 AS33E46 FTES MUC

o
. . . . 020312 1460 Requested Kunde3, Test PENDING 020812 00:10 - 02:20  AG33/246 FTE2 MUC
you a quick indication on the current
0BMIM2 12:25 Cancelid Kunds3, Test3 ©OBA3MI 1845 2315 A343FTITFRA 0}
status of each transaction (red - 0712512 14:55 Canceled Kunde3, Test3 - DTEOMZ 1815-2315  A343FTI0FRA 0}
“ rej e Cted “an d ye I I ow =" pe n d | n g ") . 0712412 11:49 Confirmed LFT Planring OFFER  O7/20M2 23:20-0320 A333FT47 FRa 0]
OF/24012 11:49 Requested Kunde3, Testd PENDING OF/29A12 2320 - 03:20  A333 FT4T FRA
® 0712312 13:00 Canceled Kunde3, Test3 FENDING 0724112 2320-0320 A333FT47 FRA 0}
® 0742312 12:21 Cancelid Kunds3, Test3 PENDING  O7M2SM2 2320 0320 A333FT47 FRA 0}
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4. The Shopping Cart

B All transactions processed in MySIM are

collected in the shopping cart for your Shopping Cart to Booking Oveniew > | _taListview >
final approval. From here you can send
your requests directly to the Lufthansa Smustr  Orer  Dae  Time R ——
Flight Training simulator planning team. 2272 == 27 o0 e omen v
Just accept the General Terms and > Remove
Conditions and click on “Send”.

B You can also clear your shopping cart v@
entirely by one click on “Clear Cart”.

%

B Shopping carts hold your transactions up | Attention
to a maximum of 30 minutes. Then a o e o 1o Lutanea FIgHt Taming iy | e plesse sens
window will appear to inform you that your | Peveueniosetomeshoseingcan?
transactions will be deleted if you don’t R i .
forward them to LFT.

Your Online Booking Portal MySIM - A Step-by-Step-Guide
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5. Availability Request

Availability Request

Inarder to request available slots foryour training please fill outthe form below, Fields marked with an

asterisk * are mandatory,

Simulatar

Customer®

Ajrcraft Tepe®

IF’Iease select

Dryivet and Training Purpose

- IPIease select

[«

IF’IeaSe select

[«

B Please select the option ‘Availability e aings
» Booking Crverdew
Request’ from the welcome page in > Lzt
Availability R st
MySIM. H Eluet:?s.te
> Ann equirernent
> FAQ
B A new window appears. After having ——
provided all relevant data please click on S
“Send yOUI' requeSt". Travel Services
» Flighttickets
B You will receive a note saying that your

Please indicate the time frame forwhich you want to request avallabilities

Change Password

request has been successfully sent to

Working group

Lufthansa Flight Training.

B Your request will be sent as an e-mail to
the planning team who will quickly look

Sendyour Request

after your request. >
‘ Q ‘four request has been successfully sert to Lufthansa Flight Training.

Your Online Booking Portal MySIM - A Step-by-Step-Guide
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6. Booking Request (1/2)

B Please select the option ‘Booking
Request’ from the welcome page in

MySIM.

B A new window appears. You can either
make a booking request for a complete
simulator family or choose and limit your
request to one simulator or one location.

B Please provide your personal booking

information.

Booking Request

Simulatar Boakings
» Booking Crwerview

¥ List Wiew

» Availahility Request
Booking Request
> Annua ,h rement

» BCE

Downloads

» Technical Simulator Documents

Travel Services
» Flight tickets
» Hotels

» Gther Travel Services

Flease choose your favorite full-flight simulatar and the respective sessions.

Customer Information

Custamer®

IF'Iease select i

Simulator

Sirmulatar Family*

- Optionally you can limit your request to one simulator or one

Fleaze select
I “lecation.

Simulator Location

Flease select i Please select id
Change Passward ! o I o
Working group

Booking Information

Drytvet and Training Purpose® Crewy Mumber

[Please select L |

Sub Custarmer Lesson Mumber

Your Online Booking Portal MySIM - A Step-by-Step-Guide
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6. Booking Request (2/2)

B You can add more requests by clicking on @'mm@
the provided box. Date Preferred slot SIM slot (in hrs.)
[ | ¥ Selectal +| [Please select | v

% onsider only exact dates for yaur request.

M A text box is also available in order for you to
Communlcate any further queStlonS Or o Consider range of +i- 7 days far your request

wishes in a direct and quick way.

B To complete your booking request, please Your message
click on “Send your Request”.

Flease indicate more information here if necessan:

© Consider range of +~ 3 days for your request.

5

M You will receive a note saying that your
request has been successfully sent to
Lufthansa Flight Training.

Send your Request )
> ‘ 0 Your request has been successfully sent to Lufthansa Flight Training. ‘
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/7. Annual Requirement (1/4)

Your simulator bookings.

B Please select the option ‘Annual Requirement’  simuator 8ookings

3 Hooking Overiew
from the welcome page in MySIM. > Listview
¥ Availability Regquest

» Booking Request

B Please indicate your annual training volumes
here and keep them up-to-date — divided into

» 8C8

recurrent trainlngs1 type ratings and Other “fou just would like to check, whether all your sessions are already booked? Here we offer you the

ossibility to check your sessions in an eas ay and of course you can add new requests
Travel Services P i v N easy way you can 3

tralnings. > Flighttickets

> Hotels

Annual Requiremer

ator Documents

» Ciher Travel Services

® |t will help you to achieve a higher degree of ~ 77
planning certainty and it will help us to
allocate the right amount of simulator capacity
for you at all times. e

Usge Filter »

Annual Requirement

Please indicate your training requirements here. You can announce the rzquired amount of training hours far the upcoming months.
Thess indicatians help you 1o achizwe a highsr degree of planning esrtainty via eatly reservation of your required trainings.

Custamer Customer Code  Simulator Family  Dry/Wet Lease  Last Updated
DRY Q400 Dry 0971812 Show Edit
TITNG Dry 0B/2312 Shovw Edit
#3270 Dy 08730412 Show Bt
7ITCL Dry 09072 Shovw Edit
Craate New >

\Figgreggline Booking Portal MySIM - A Step-by-Step-Guide @ Lufthansa Flight Training



/7. Annual Requirement (2/4)

B Step 1. Please select the relevant simulator

family and whether you would like the training e e e

slots in Dry or Wet Lease.
Step 142
B Then click on ‘Next’. customer-
[Please select Ll
Simulator Farmily™ Dy fiet Lease
[Please select Ll [Please select Ll

i

Your Online Booking Portal MySIM - A Step-by-Step-Guide @ Lufthansa Flight Training
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/7. Annual Requirement (3/4)

Annual Requirement

B Step 2: Please indicate your estimated training Step2/2
demand in hours into the specific boxes. S
Dry et Lease et
B Please feel free to add any comments
regarding your estimated training demand in o ot g, et otter

the provided “Comments” box.

March 2013

April 2013

B Click on ‘Complete’. ey 2013

June 2013

August 2013

September 2012

Octoher 2012

Movernber 2012

December 2012

[ [
[ [
[ [
[ [
[ [
[ [
July 2013 | |
[ [
[ [
[ [
[ [
[ [
0 0

Total Hours Hours Hours

Cancel > Complete >

Your Online Booking Portal MySIM - A Step-by-Step-Guide Eé) Lufthansa Flight Training
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/7. Annual Requirement (4/4)

B A new window appears, informing you that

your changes will be saved and a mail will be - %
sent to Lufthansa Flight Training. Please click Annual requirement
on ‘Save’.

Your changes will he sawved and a rmail will he sent to LFT.

B A note will appear saying that your annual
requirement evaluation has been saved
successfully.

Cancel > Save »

> | ° The annual requirement ewaluation has been ssved successfully.
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